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Electronic Case Filing System
User’s Manual

Getting Started

Introduction

This manual provides instructions on how to use the Electronic Filing System to file documents
with the court, or to view and retrieve docket sheets and documents for all cases assigned to this
system. Users should have a working knowledge of word processing, web browsers, file
management and Adobe Acrobat.

Help Desk

Contact the Court’s ECF Help Desk for assistance between the hours of 8:00 a.m. - 4:30
p.m., Monday through Friday.

Local: 612-664-5155
Toll Free: 866-325-4975

OR E-mail: ecfhelpdesk@mnd.uscourts.gov

Access to ECF Information and Resources

For up-to-date information regarding ECF, visit the U.S. District Court web site at:
www.mnd.uscourts.gov

The CM/ECEF link provides access to:

+ Livelogin to CM/ECF

« Automated Password Reset

+ General Information

+ Training Information

+ Reference Guides and User’s Manuals

- CM/ECF Help
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Central Sign-On (CSO) Account

In NextGen ECF, a Central Sign-On Account provides access to both PACER and ECF with a single login
and password. Once logged in with a CSO account, admitted attorneys with filing privileges can:

+ Electronically file pleadings and documents

+ View official docket sheets and documents

« View various case related reports

Public Access to Court Electronic Records (PACER) Access

PACER is an electronic public access service that allows users to obtain case and docket information from
Federal Appellate, District and Bankruptcy courts, and from the U.S. Party/Case Index. Attorneys must
have an individual PACER account in order to file in the ECF system. All requests for ECF filing privileges
are submitted through PACER. You may register for a PACER account online at http:/ /www.pacer.gov/.
Your CSO Account is maintained through PACER. Name, address, login, password and primary email
address information can be updated in the “Manage My Account” section of PACER'’s website. If you have
forgotten your PACER username and/or password, PACER has an automated password reset and
username recovery on the PACER Login page.

Electronic Case Filing (ECF) Access

Existing attorneys (those who were admitted in the District of Minnesota prior to October 5, 2015 and have
an active ECF account) will link their ECF account to their individual PACER account for filing access.
Please see the NextGen Information page for additional information and procedures.

Attorneys seeking admission and filing access must make a request through PACER. Please review the
attorney admissions forms for specific instructions. Please note that pro hac vice and Multi District
Litigation (MDL) attorneys also obtain filing access with the court through PACER.

Attorneys will only retain filing access while in good standing with this court. To be in good standing, an
attorney must comply with the requirements of LR 83.6, including timely payment of the re-registration fee
due every third year during the court’s re-registration process. If you do not re-register with the court, your
admission status will become inactive. You will need to re-register with the court to return to good standing
and have filing privileges reactivated. After being admitted, attorneys must file a notice of appearance in
the case(s) they wish to appear as attorney of record.
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Logging in to ECE/PACER through CSO (Central Sign-On)
1. Click on the U.S. District of Minnesota - Document Filing System link. To access this linkeither:

Welcome to the 1.5, District Court for the T2, District of Minnesota

.3, District ofl\ﬁ.rmesota_ sDocument Filing System

a. Navigate to https://ecf.mnd.uscourts.gov/cgi-bin/ShowIndex.pl
OR

b. Navigate to the District of Minnesota’s Web site at: www.mnd.uscourts.gov and click onthe
NextGen ECF LINK on the left panel.

Home CM/ECF | JuryDuty | MDL | Calendar | Information | CourtForms | New Cases
“fou are here: Home = "_‘ Adobe Download b;h Print this page
Attorney Information | SCAM ALERTS: Throughout the United States, including in Minnesota,

: citizens are being targeted by emails, phone calls and postal mail. Please |
Community Outreach ' click here for more information.
Courthouses .

Courtroom Technology

o -~
Criminal Debt m"'l'l'l'l'l""':::':ﬁ:‘"
Employrment 41t
Judges

Duluth

Judicial Complaints
Local Rules
Media Information

Minnesota's Clmstead Plan

I NextGen ECF LINK I

2. Enter your PACER/CSO Username and Password in the appropriate entry fields.
Note that the Client Code is an optional field that can be used for organizing your monthly bill
to associate costs to specific clients.

_

Username *

Password *

Client Code

Login Clear Cancel

Meed an Account? | Forgot Your Password? | Forgot User Mame?

MOTICE: This is a restricted government web site for official PACER use onhy. Unauthorized entry is
prohibited and subject to prosecution under Title 18 of the U.5. Code. All activities and access
attempts are logged.
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3. Check the box confirming you will comply with the redaction rules. Click Continue and the
main ECF screen will appear.

Ik Lo LY
R o e

IMPORTANT NOTICE OF REDACTION RESPONSIBILITY: All filers must redact Social Security or taxpaver-
identification numbers; dates of birth; names of minar children; financial account numbers: and, in
criminal cases, home addresses, in compliance with Fed. B, App. P 28(53(5), Fed. B. Civ P 5.2 Fed R.
Crim. P 491, or Fed. B, Bankr P 9037, This requirement applies to all documents, including attachments.

Ib | understand that, if | file, | must camply with the redaction rules. | have read this notice.

Continue Cancel i

A4
e ————————————

Logging Out

After you have completed all transactions for a particular session in ECF, you should exit from the
system.

1. Click Logout

2. A pop-up message will appear stating, “ Although you have logged out from CM/ECF, data
remains in the browser’s memory (and might be available to someone else using your PC).
Please close your browser now to clear this data.”

Maintaining Your Account

All account information, other than secondary email addresses, is held in your CSO account and can be
accessed through the Manage My Account option on PACER’s website (www.pacer.gov). It is each
attorney’s responsibility to keep the account information up to date.

W PACER

PUBLIC ACCESS TO COURT ELECTRONIC RECORDS

Email Information

The primary email address is added and updated through PACER. Secondary email addresses are only
added and updated through ECF. Email addresses are used for Notices of Electronic Filing (NEF’s). It is
recommended that all accounts include a primary email address and at least one secondary email address
for the purpose of receiving NEF's.
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Please note: with the implementation of the new Central Sign-On functionality in the Next
Generation (NextGen) of CM/ECEF, filers now access PACER and NextGen CM/ECF systems using a
single PACER account. If attorneys share these account credentials with a third-party service
provider, the provider would be able to access restricted documents (including sealed documents) to
which the filer has access. If the third-party service providers place the restricted documents, they
obtain in internet repositories, other users of the third-party service or software may access the
documents and/or make them publicly available.

Updating Primary Email

1. Navigate to www.pacer.gov. Note that this can also be accessed through ECF by clickingon
Utilities>Manage your PACER Account

2. Click on Manage My Account

ount | Manag ellate Filer Account | © earch Sign In

W PACER

PUBLIC ACCESS TO COURT ELECTRONIC RECORDS

3. Click on the Maintenance tab.

4. Click Update E-Filer Noticing and Frequency

| Settings |I Payments | Usage T

Update Personal Information Attorney Admissions ¢ E-File Reqistration
Update Address Information Hor-Attorney E-File Registration

Update E-Filer Email Moficing and Freguenqgl Check E-File Status

Display Registered Courts E-File Registration/taintenance Histary

5. Check the box to apply your changes to the District of MN.
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6. Enter and confirm the Primary Email Address, select frequency and format preferences and click
Submit.

Apply Updates to Selected Courts

U.8. District Courts

Minnesota District Court (Test) - NextGen
Click to apply changes to this court

Click here to load this courts E-Filer email noticing and frequency information below

Email testusen@testuser.com

Email Frequency Each Transaction

Email Format HTML

Additional email addresses for district and bankruptcy e-filers must be added through the CM/ECF
Maintain Your Account utility.

* Reguired Information
Primary Email =

Confirm Primary Email

Email Frequency * Select Email Freguency
Email Format * Select Email Format
Submit Reset cancel

7. The following confirmation screen will appear. Click Close.

A
Your emailfnoticing changeis) have been sent to the selected courts for review and processing. Please note

that this process may take some time, and there is a possibility that the court may not accept your change.

Close

Updating/Adding Secondary Emails
1. Click Utilities > Your Account > Maintain Your Account
2. Click Email information at the bottom of the screen.

Bar Membership ID

Bar Membership Status CJA Status
Primary Phone Fax
Alternate Phone Text Phone
Initials DOB

58N Drivers License Number Drivers License State

Attorney Admissiops Documenis

Document Description

Email information... | [ More user information..
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3.If a primary email address is listed, skip to step 5. If no primary email address is listed, click add
new e-mail address. Note that although primary email addresses are maintained through PACER,
there must be one listed in ECF in order to add secondary addresses. Enter the account's PRIMARY
email address. Once an address is entered, the secondary email address options will appear on the
left.

4. Click add new e-mail address under Secondary e-mail addresses.

Registered e-mail addresses

Primary e-mail address:
testuser@testuser com

Secondary e-mail addresses:
| add new e-mail address |

’ Feturn to Person Information Screen ” Clear l

5. Enter the secondary email address and change the configuration options if desired. Note that
multiple secondary email addresses can be added by clicking on add new emailaddress.

Configuration Options:

Option Description

Should this e-mail address | For the primary email address, the default is Yes. If set to No, the
receive notices? primary email address will not receive notices of electronic filing
(NEFs) —this is not recommended.

How should notices be Per Filing: Email sent for each individual filing
sent to this e-mail address?
Summary Report: One daily email listing all transactions for that
day, sent on the following day

NOTE: If the Summary Report is selected, an additional prompt
appears, “Should this e-mail address receive a ‘no activity” notice
when no summary noticing occurs?”

¢ Yes: an email will be sent with the message, “no transactions
found for this time period” when no activity occurs in thecases
for which the user is configured to receive summarynotices

¢ No: no email will be sent unless there were filings

In what format should Controls the format of the emails — HTML is generally preferred.
notices be sent to this e-
mail address?

Should this e-mail address | The court prefers that users select Yes so that they will receive email
receive general notifications regarding important ECF system information such as
announcement notices down-time and upgrades.

from this court?
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6. To remove a secondary email address, click on the address on the left and deleteitin the text
box on the right.
Registered e-mail addresses Configuration options
Primary e-mail address:
testuserftestuser com attorneystaff@test. com Delete

Secandary e-mail address Should this e-mail address receive notices? @ Yes [ 1
attornevstaffitest. com

add new e-mail address

Should this e-mail address receive notice for all cases in

[ Return to Person Information Screen I [ Clear J Howr should notices be sent to this e-mail address? @ P

7. After all changes have been made, click Return to Person Information Screen. DO NOT use the
Back button in your browser- information will not be saved if you click Back.

Registered e-mail addresses Configuration options
Primary e-mail address:
testuser@testuser cam attorneystaff@test.oom|
Secondary e-mail addresses: should this e-mail address receive notices? @ Yes O 1
attornevstaffidtest. com
add new =-mail address Sheould this e-mail address receive notice for all cases in
I[ Return to Persaon Information Screen Ill Clear I How should notices be sent to this e-mail address? @ P

8. You will return to the main account maintenance screen. Click Submit to save changes. A
confirmation screen will appear.

Office Test Firm
Unit

Address 1

Address 2

Address 3
City State
Country County

Firm

Bar Membership ID
Bar Membership Status CJA Status
Primary Phone Fax
Alternate Phone Text Phone
Initials DOB
SSN Drivers License Number

Attorney Admissions Docunienis

Document Description
[ Email information. . I [ Iore user information...
Submirﬁ

9. If the Clerk’s Office receives a “bounce back” (i.e., an undeliverable e-mail) notice from a Registered
User’s primary or secondary e-mail account, no follow up will occur by Court staff. It is the
Registered User’s responsibility to update all information as it pertains to the user’saccount.
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10. Continue working in ECF by clicking on any menu item at the top.

CM ECF Civil~ Criminal- GQuery Reports. Utilities~ Search Help Log Out

View Your Transaction Log

As a free service, ECF filers may view their transaction logs. This may be helpful to verify that all

transactions entered are reflected in the system, and that no unauthorized individuals have

entered transactions into ECF using your login and password.

1. Select Utilities > Your Account > View Your Transaction Log

Utilities

Your Account Attorneys & NEFs
Change Client Code Mailings. ..
Change Your PACER. Login
Review Billing History
Show PACER Account
Remove Default PACER Account
Maintain Your Account

View Your Transaction Log

RSS Feed

EECF Civi ~  Criminal~ Query Reports ~ |

Utilities
Your Account
Attorneys & NEFsk

Search

Change Client Code
Change Your PACER Login
Review Billing History

Show PACER Account

Remove Default PACER Account
Maintain Your Account

View Your Transaction Log

RSS Feed

The following window will appear:

Criminal ~ Query

Reports

VView Transaction Log

Enter the Date Selection Criteria for the Transaction Log Report

Start Date: |1/1/1996 End Date: |EJSI2EH1
Run Report | Clear |

2. Enter the Date Parameters, Click “Run Report”

The following window will appear listing the transactions for the designated dates
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= il —— ; ’ fiities ~
uECF Civil Criminal Query Reports Utilities Search Logout

3. Continue Filing or Logout of ECF
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Requirements

Hardware and Software Requirements

The hardware and software needed to electronically file, view and retrieve case documents are the
following;:

« A personal computer running a standard platform such as Windows or Macintosh

« A PDF-compatible word processor like Macintosh or Windows-based versions of
WordPerfect or Microsoft Word

+ An Internet Service provider

« A Web browserSoftware, such as Adobe Acrobat, to convert documents from a word
processor format to portable document format (PDF).

« Adobe Acrobat Reader, which is available for free, is needed for viewing PDF documents

« A scanner may be necessary to create electronic images of documents not in your word
processing system

Note: Scanning is only used for documents that cannot be produced electronically.
Scanned documents lessen the level of service we provide by slowing down the entire system.
We are moving away from the utilization of scanned documents internally and ask you to
do the same whenever possible.

How to View a PDF File
1. Start Adobe Acrobat program
2. Click File menu > Open
3. Click the location and file name of the PDF document to be viewed
4. Adobe Acrobat Exchange loads the file and displays it on the screen

Note: If the displayed document is larger than the screen or consists of multiple pages, use
the scroll bars to move through the document. Click the View menu for other options for

viewing the displayed document. Choose the option that is most appropriate for the document. How to

Convert

Documents to PDF Format

The conversion process requires special software such as Adobe Acrobat Writer or FinePrint
pdfFactory. Some software (e.g., WordPerfect and Microsoft Word) have Acrobat components
built-in or available as add-ins. These can be used to convert documents to PDF. The District
Court of MN is not concerned with what software is used to convert the file. Options besides
Adobe Acrobat include any features already in your word processing software, or any of the
following;:

+ 602Pro Print Pack 2002 » LeadTools ePrint 3.0

« BCL easy PDF 3.1 » pdf995 and pdfEdit 995
+ eDocPrinter PDF Pro 5.58 « PDF-XChange 2.5

+ eXPert PDF Printer 2.0 « Jaws PDF Creator 3.0
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« FinePrint pdfFactory PRO 1.57 « Win2PDF Pro
Once PDF conversion software is loaded on your computer:

a. Open the document to be converted
b. Select Print option (generally found in the File menu)

Change printer option to the PDF choice available (A drop-down menu with a list of
printers is displayed)

Print to Adobe PDF EE:

M ain |La_|,Jout| Advanced

—

Adabe PDF j\ﬂoperties._. |
Syatern Default Printer
Frinters... |

Skatu I

Microzoft Office Document [mage 'Wiker
| AT s s =

d. “Print” the file. The file should not actually print out; instead the option to save the file as a
PDF format file appears (below):

Save PDF Fila Ac 2 x|

Save jn I 23 Attarney ] | | §| |
7] civilcouersheel PO [ response in opposition. PDF
-> E complaint. FOF '@ gummany judgment. FOF
E ECF Manual with criminal2. POF
E e pdf
E order on motion. FDF
E order rerferring motion.POF
E randr.POF
, _ —— ™\
File: name: IEI:F b anual with criminal 2. PDF Save /’
Save a3 type: |PDF fil=s [*PDF) = Cancel
Edit Dacurnent nfa. [~ “iew POF File
| Note: Make a note of the file location so you can find the document

later when you are ready to upload it to ECF.
Change the location if necessary by clicking in the “Save in” area of the window.

e. Name the file, giving it the extension “.PDF” and click the Save button.

NOTE: Depending on the word processing program being used, it may be necessary to
find the printer selection option elsewhere. At that point, change the printer to
Adobe PDF, and follow the directions above.
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PDEF/A Documents

PDF/ A is a standard format that allows for the long-term archiving of electronic documents with
the assurance that the documents will be accessible in the future. CM/ECF will now accept both
PDF and PDF/ A documents.

Creating a PDF/A with Microsoft Word
1.  Tocreate a PDF/A directly from MS Word, the user must update the PDF conversion
settings. In Word 2007, click on Preferences in the Acrobat menu in the ribbon:

e |
J Home Insert Page Layout References Mailings Review View Menus Arrghat
[—1 | % m— —

e <+ = 5
Create Preferences Create and Mail Create and Send  Acrobat

PDF Attach to Email Merge For Review  Comments =

Create Adobe PDF Create and Email Beview And Comment

In older versions of Word, go to Adobe PDF>Change Conversion Settings to access the PDFMaker
window.

2. In the PDFMaker window, click the Create PDF/ A-1a:2005 compliant file checkbox, then
click OK.

= Abiobal FOFMsker |
Selings | Secuiy | werd | Bockmarks |

~ POFMsker Sattings —— =

Conwersion Setings [FOF 1L 200 0L =
i Lz these sstigs bo cesate Adobe POF documents Shet s bo be checked o must =
conform o POF A5, an P50 standand foe the long temn presersation jacchivall ol =)

F Wiew &dobe FOF resul
¥ Frompl for fidobe FOF Hs nane

Midobe, the Adcbe logo, Acrobat, e Adobe FOF loga. PostScrpl, and R eader ais
i &ad:ﬂiorha@unukgnl.ﬁmbEGBmmlmpmmdhlhe

r ‘0 o 2005 Adobe Syedan Incoporated snd de baengots, A0 sghls repeyed
" eithes
Adabe Undted Slates anddor oier courizie:

Restoes Difauts of | Cancel Hee |
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Creating a PDF/A with Corel WordPerfect X4

Note: Older versions of WordPerfect do not include PDF/ A in the Compatibility options.

1.

2.

To create a PDF/ A directly from WordPerfect X4, click on File> Publish to PDF, then click

Settings.

Publish 1o PDF

Savein | ) My Documents

i Coral User Fles

L ) Dl
Deskicp | dFkider2
IHTML
Ay Music
Sty Pictures
ity Shapes
| My Wideos.

3
@ v

| SpAmasSasSH

|

i
¥
:

| J?’ v [~

My Racent JiCropper Captures
Documerts 7 Diagnostic Tool for the Mcrosoft v

‘) Dowrioaded Program Lipdates

) Mty irtuad pachanes
armghbwests def st

oot | v
Custorn (Current settings not saved) -

1 Gpen FOF After Saving

2 Werking File
T ath - 02492
= ath - 08436
=6t - 07-17&
= ith - 0519
= 10th - D510
= o72ldesa
i0740dezal
2009 NGS O
T 15205desa
"= 1estadesion
20175 6110
= msi

T 0o15136-P04
= ACOZ11ECF2

In the Publish to PDF Settings window, select PDF/ A-1a from the Compatibility dropdown,

then click OK.

Publish to PDFE Settings

Ewpott rarge
(#) Full document

|

Genesal | Objects | Document | Advanced | Secuily |
File name:  CADocuments and Setngs\WONHINEC My Documents\Document] . pe

{7 Cumrent Page
O Pages: |

Coenpatibdity: THFT’L;:IFJAJ a_

Author Acrobat 4 [PDF 1.3)
Actobat 5 (PDF 1.4)

hep |
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Using Hyperlinks in PDF/A Documents

To access hyperlinks in a PDF/ A document, in Adobe Acrobat/Reader, go to Edit> Preferences>

Documents, and select Never in the PDF/ A View Mode dropdown list.

Freferences
Cabegories: - Open Settings
DocLmence [~ Restore last view settings when reopening documeants
Full Screan [¥ open cross-dooument links in same windaw
iseneral
Pa::rmﬂuy [# alewi layer state to be sat by user nfarmation
[¥ @low documents to hide the menu bar, toolbars, and window controls
30 & Multimedia |
Aecesshiliy Dooumants inrecandy used lisk: E i
furobat.com
Ferens
Identity
International Save Setkings
Intesnel : ¥ .
JavaSarit [¥ &utomaticalls save dacument changes to temparary fils svarys 5 minltes {1-59)
Maasuring (20) ¥ Save s optimizes For Fast Wb View
M asuring (30 L
b Joo [Croriieniee—]
Nt g POFA Yiew Mada
Pulkimedia Trust {legacy) View documents in POFIA mode: [ Oriy For PDEJA documents =
Search
Security
Securicy {Enhanced)
Speling
Tracker
Trust Manager
Linits

‘Cancel
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General Information

Filers will use the Criminal feature of ECF to electronically self-file and docket with the Court a
variety of pleadings and other documents for criminal cases.

Selecting ECF Features
The following features are accessible from the menu bar at the top of the main window.

CM ECF Civil » Criminal~ Query Reports. Utilities~ Search Help LogOut

Feature | Use this option to:
Civil Electronically file all civil case pleadings, motions, and other court
.. Electronically file all criminal case pleadings, motions, and other court
Criminal
documents.
Search by specific case number, party name, or nature of suit to retrieve
Query documents that are relevant to the case.
You must login to PACER before you can query ECF.
R Retrieve docket sheets and cases-filed reports. You must login to PACER
eports .
before you can view an ECF report.
legs View your personal ECF transaction log and maintain personal ECF account
Utilities | . :
information.
Use to find and get to the menu option or docket event that you need. Type
in a partial or full word and a complete list of menus and events containing
Search o . . . e
the word is displayed. The items appearing are links to additional
information about the topic or to the first screen of the searched event for
Sign out of ECF and prevents any filing with your password until the next
Logout | time you log in. Only one user can be logged in using the same
login/password at once.
See a help file for the screen you are viewing.

General Rules and Manipulations

Correcting a mistake:

Use the [Back] button on the browser toolbar to go back and correct an entry made on a
previous screen. However, once the document is transmitted to the court, only the court can
make changes or corrections.
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Signatures; Affidavits of Service

A pleading or other document requiring a signature must be signed in the following manner:

s/Pat Attorney

Pat Attorney

Bar Number 12345

Attorney for (Plaintiff / Defendant) XYZ Company
ABC Law Firm

123 South Street

Minneapolis, MN 55415

Telephone: (612) 555-5555

Fax: (612) 555-5554

emailaddress@domain.com

In the case of a stipulation or other document to be signed by two or more persons, the
following procedures apply:

a. The filing party or attorney shall initially confirm that the content of the document is
acceptable to all persons required to sign the document and shall obtain the physical
signatures of all parties on the document.

b. The filer then must file the document electronically, indicating the signatories with an
“s/signature” (e.g., “s/ Jane Doe,” “s/ John Smith,” etc.) for each signatory.

c. By filing the document, the attorney certifies that: (1) the document has been signed by all
necessary people, including affiant and notary; and (2) if applicable, and the ink signed
originals exist and will be available in their office for inspection. These documents should
be retained in accordance with the retention rules required by the Eighth Circuit and
Federal Circuit.

d. A non-filing signatory or party who disputes the authenticity of an electronically filed
document containing multiple signatures or the authenticity of the signatures themselves
must file an objection to the document within 14 days of service of thedocument.
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Mailing information for a Case

Attorneys can check ECF to see if a party is registered to receive e-mail noticing before uploading a

filing in ECF.

1. Select Utilities > Miscellaneous > Mailings > Mailing Info for a Case

Criminal ~

Query

[Utilities

Your Account
Change Client Code
Change Your PACER. Login
Review Billing History
Show PACER. Account
Remowve Default PACER. Account
Maintain Your Account
View Your Transaction Log

ESS Feed

Attornevs & NEFs

Mailings...

2. Select Mailing Info for a Case

Tailings

Mail Motification Fequests

|MaiTEng Info for a Ca&e|

Mailing L abels by Case

3. Enter the Case Number, Click “Find This Case” then Click “Sumbit”

The following window will appear:

SECF

Civil ~

ailing Information for a Case

Criminal ~

Enter the case number to view the recipient lst.

ase Number: IUB-CH

Subirnit | Clearl

Find This Case |

Query

1. Enter the Case Number, Click “Find This Case”
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The following window will appear listing the Case Number:

Mailing Information for a Case

[Enter the caze number to view the recipient list.
Case Number: IDZDB-EH

Subrmit | Clearl

2. Click “Submit”

A window similar to the following will appear with case specific mailing information:

EE F Civil - Criminal ~ Query Reports -~ Utilities

Mailing Information for a Case 0:08-cr-00001-ADM-A.JB

[Electronic Mail Notice List

The following are those who are currently on the hst to recewve e-maitl notices for this case.

+ attorneyl
attorney 1 (@Emnd. gow

Mhanual Notice List

[The following is the list of attorne

who are not on the list to receive e-mail notices for this case (wh)
tmouse to select and copy this list

o your word processing program in order to create notices or lab

feff Paul=sen

.

atherine Boe

NOTE: If any attorney names appear under the “Manual Notice List”, these
attorneys need to be noticed in the conventional manner.

3. Begin Filing or Logout of ECF.
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Filing Documents for Criminal Cases

There are eight basic steps involved in filing a document. These are essentially the same for each

event filed in ECF:

1. Select the type of document to file

2. Enter the case number in which the document is to be filed

3. Designate the party(s) filing the document

® N o U e

Criminal - Query

Criminal Case Number

|0:06-cr-5-10 Hide Case List |
Select a case:
7 0:06-cr-00005-JMR USA v. Solis etal=
™ 0:06-cr-00005-JMR-JSM-1 Javier Jose Solis
™ 0:06-cr-00005-JMR-JSM-2 Daniel Acosta
I 0:06-cr-00005-JMR-JSM-3 Christopher Lee Calvillo
I~ 0:06-cr-00005-JMR-JSM-4 Froyd Cuadrado
™ 0:06-cr-00005-JMR-JSM-5 Antonio Cuadrado

™ 0:06-cr-00005-JMR-JSM-7 Neftaly Sierra-Serrano
™ 0:06-cr-00005-JMR-JSM-8 Jayson Caraballo Rivera

I 0:06-cr-00005-JMR-JSM-10 Robert William Cruz
" 0:06-cr-00005-JMR-JSM-11 Sincere Yero Page-El
™ 0:06-cr-00005-JMR-JSM-12 Odean Garner

pleading on behalf of ALL defendants.

Criminal = Query

Criminal Case Number

|0:06-cr-5 Hide Case List |
Select a case:
[ 7 0:06-cr-00005-JMR USA v. Solisetal= |
I~ 0:06-cr-00005-JMR-JSM-1 Javier Jose Salis
™ 0:06-cr-00005-JMR-JSM-2 Daniel Acosta

I~ 0:06-cr-00005-JMR-JSM-4 Froyd Cuadrado
™ 0:06-cr-00005-JMR-JSM-5 Antonio Cuadrado

™ 0:06-cr-00005-JMR-JSM-6 Angela Dominga Cuadrado

I~ 0:06-cr-00005-JMR-JSM-3 Christopher Lee Calvillo

a. IMPORTANT: If the case has multi-defendants, be sure to only select the defendant
you represent and on whose behalf you are filing the pleading for.

Reports -

b. Please do NOT select the box next to the master case, unless you are filing the

Add attachments, if any, to the document being filed
Modify docket text as necessary
Submit the pleading to ECF

Receive notification of electronic filing

Specify the PDF file name and location for the document to be filed
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Filing a Motion

This section of the User's Manual describes the process for filing a Motion in ECF. The process is
similar for filing other pleadings in ECF.

Select the appropriate menu from the ECF Menu Bar for filing:

1. Click Criminal > Motions and Related Filings > Motions

Criminal -

Motions and Related Filings
Other Filings

Criminal Events

Motions and Related Filings
Motions
Supporting Documents and Responses

Other Filings

Discovery Documents
TWalvers

The following window will appear:

Civil = Criminal ~ Query Reports ~ Utilities - Search

ATTENTION: Pursuant to the Criminal ECF Procedures Guide, fwo courtesy copies of motions and supporting documents (including affidavits
and exhibits) are fo be mailed contemporaneously to the Judge hearing the matter.

Next| Clear

2. Click the Next button

The following window will appear:

Criminal = Query Reports ~ Utilities - Search

otions
IN[PORTANT: Select QONLY the appropriate individual defendant case(s) for which the motion is being filed.
Selecting the master (top) criminal case number on the next screen will result in a motion filed for ALL defendants.

Next | Clear |

3. Click the Next button
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4. Enter the case number, then:

Motions

Criminal Case Number

[08cr7] Find This Case |

Motions |
Clear | .
[Motions
Criminal Case Number Criminal Case Number
|U'08-cr-7 |U3C'3'Cf -7-1 Hide Case List
' Select a case:
I 0-:08-cr-00007-ADM-AJB USA y.
[ Iv: 0:08-cr-00007-ADM -AJB-1|C
Next | Clear | ™ 0:08-cr-00007-2 Tom Smith
Next | Clear |
If... Action Then

Important: Click the box
next to the defendant you
represent and on whose
behalf you are filing the
List of all pleading for. Please do
defendants appears | NOT select the box next to
the master case, otherwise
you will be filing the
pleading on behalf of all
defendants. Click Next

Multi-Defendant Case

Number is entered correctly,

click ‘ i [l st ‘ Click Next Nenl

Number is entered = ’——| Re-enter number, click Find
incorrectly, click Ba [Ciear This Case

Invalid case number T Re-enter number, click Find

message appears, click This Case

Click on the specific case
number you are filing in

Multiple case numbers Another window
match the one entered appears
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5. Click on the party(s) filing the document, Click Next

NOTE: If you represent multiple defendants you may select multiple parties by holding down the control
key while pointing and clicking on each party of the group.

A Notice of Appearance needs to be filed in order for the attorney to be added to the case
per the Criminal Procedures Guide, Section II. Electronic Filing and Service of Documents.

If this is the first time the attorney is filing in the case, the following window will appear. It is
necessary to create the attorney/party association as follows:

EECF Civil ~ Criminal ~ Query Reports ~

(Necessary)
6. Check the box in front of the party’s name to link the attorney and party together

Page 26



CMY/ECF User’s Manual - Criminal

U.S. District Court, District of Minnesota

(Optional)

7. Check the box in front of Lead if attorney is lead attorney

(Necessary)

8. Check the box in front of Notice to receive notification when any documents are filed inthis

case

9. Click Next

The following window will appear:

Directed “erdict
Disclosure
ry
Dismiss
Dismiss/Lack of Jurisdiction
Dismiss/Speedy Trial
Disgualify Counsel
Disqualify Judge
Disgualify Juror

Mext | Clear |

ECF Civil = Criminal - Query Reports ~ Utilities ~
Motions
0:08-cr-00007-ADM-AJE LUSA v, Elingson
400
Di Click your selection, or use arrows to lughlight it and press Enter.
Available Events (click to select an event) Selected Event
Counsel to Participate in Vair Dire |Discovery

10.Click the type of motion being filed. It will appear on the right side of the window, Click

Next

NOTE: An alternative when looking for the motion to select, type a portion of the
event name to reduce the length of the event list.
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The following window will appear:

hd Criminal~

Reports

0:08-cr-00007-ADM-AJB USA v. Ellingson
ADINV

Select the pdf document and any attachments.

|Main Document

Browse_ |

Utilities -

Search

Attachments Category

Description

1.| Browse_ “

=l

MNext | Clear |

NOTE: You must attach an electronic copy of the actual pleading during these steps.
All documents filed in ECF MUST be in PDF format. 11.

Please refer to the Criminal Procedures Guide, Section VI. Exhibits for additional information.

12.Click Browse to locate the appropriatedocument

The following window will appear:

Look i I ‘= Criminal Filzs j & £ E2-
Ellingson
Hame | Sizal Tvpe | Modified
) affidavit. pdf TKE Adobe Acrobat Doc...  O1/11/2008 1:47 PM
affidavit,wpd 7KB WPD File 0171172008 1:40 PM
T certificatenfservic... 9KE Adobe Acrobat Doc...  O1f11f2008 1:48 PM
certificateofservic,.. 9KE WPD File 0171172008 1:39 PM
-_";]exh 1-5.pdf Z0KE Adobe Acrobat Doc...  OSf08/2007 1:17 FM
-";]exh 6 - &.pdf Z0KE Adobe Acrobat Doc...  05/08/2007 1:17 FM
- CA19%cwa01-21 ¢ T exhibit. pdf 7KE Adobe Acrohat Doc...  01/11/2008 1:49 PM
TKE Adobe Acrobat Doc...  O1/11/2008 1:49 PM
— 20KB Adobe Acrobat Doc...  0S/08/2007 1:20 PM
_Browse.. |
0 Yes Bl | »
File name: [motion for discovery. pal =l Open | -
| Files of type: IAI\ Files [%.7] j Cancel |

]

13. Navigate to the appropriate directory and file name of the PDF document to befiled
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14. Click on the file name and Click Open (or double-click on the file) to link it to thefiling

NOTE: It is recommended for the user to verify the correct document has beenselected
before linking it to the filing. To do so, right-mouse click on the selected file.

A short-cut menu will appear. Click Open

Choose file

Laak i | (=3 2009 Crininal Class Practice Files x| & & ek E-

| affidavit, pdf

affidavit. wpd
Qcert\FicateoFservice.de
certificatenfservice, wpd
ﬂexh 1-5.pdf
iexh & - g.pdf

T exchibit pdf
i]memo.pdf

& motion for discoy

My Documents

Select |

Open with Acrobat &
My Liter Print

Adobe Acrobat or Reader will open the PDF document. View and confirm

document to be filed. Close the Adobe program.

From this point forward, this informative note will not be included in the documentation.

The following window will appear:

Criminal ~

0:08-cr-00007-ADM-AJB USA v. Ellingson
4DV

Select the pdf document and any attachments.

|Main Docoment
C\Documents and Settings\ellingso\My| :Browse._:

Utilities - Search

Attachments

Description

1.| Browse_ ||

=l

Mext | Clear |
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15. If there are No Attachments to the Motion, click Next

The following window will appear:

0:08-cr-00007-ADM-AJB USA v. Ellin
4DV

NOTE: Unless filing an amended document,
use of the drop-down options is not
recommended; editing the docket text field is
acceptable when appropriate.

Docket Text: M as Appropriate.
*| MOTION for Discuveryl by Corey Ellingson. (attorneyl, )
MNext Clear I

16. Click Next

The following window will appear:

Civil - Criminal - Query Reports - Utilities ~ Search

0:08-cr-00007-ADM-AJB USA v Ellingson
4DV

Docket Text: Final Text 1 ”
MOTION for Discovery by Corey Ellingson. (attorney1, ) lele Source Document.s Path
is solely a marker to list the

Attention!! Pressing the NEXT button on this screen commits W document/ s attached to this

dify this transaction if ontinue. o1s
o S filing event.

S D FPath (for confi ion only):
Exfiitramingicmecf2009 Files\2009 Criminal Class Practice Files\motion for discovery pdf  pages: 1
Clear ]

17. Confirm information in window, Click Next to submit the Motion

NOTE: This is the last screen to view before submitting the pleading. If corrections need to be
made, click the Back button to locate the desired window in which changes are needed.
To abort this filing event, click any item on the blue menu bar.
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The Notice of Electronic Filing window appears:

Criminal ~ Query Repeorts ~ Utilities ~
Motions
401V
1.8, District Court
U.S. District Court of Minnesota
patss et Eertenatiing NOTE: The Notice of Electronic Filing (NEF)
The following transaction was entered by alterney 1, on 2/4/2009 at 1.3 confirms the Completion of this flhng
Case Name: TUSA v Ellingson
Case Number:  0:03-cr-7 event and acceptance by the ECF system.
Filer: Dft No. 1 - Corey Ellingson . . . L
Document Number: 9 This pleading is now an official court document.
Docket Text: The NEF will mail h r
MOTION for Discovery by Corey Ellingson. (attorneyd, } eN .be € a. ed t(? the addresses
associated with this case
0:08-cr-7-1 Notice has been electronically mailed to:
Aftorney2  attomey2(@domain com

Filing a Memorandum of Law
This section of the User's Manual describes the process for filing a Memorandum of Law in ECF.
The process is similar for filing other pleadings in ECF.

Select the appropriate menu from the ECF Menu Bar for filing:

1. Click Criminal > Motions and Related Filings > Supporting Documents and Responses

Criminal Events

Motions and Related Filings
Motions

Supporting Documents and Responses

Other Filings
Discovery Documents
Waivers
Service of Process

TTT -

The following window will appear:

= C ivil - 1mi -
uE = civil Criminal Query

Responses & Replies

Criminal Case Number

[0:08-cr7

[ext | Clear |

NOTE: ECF will automatically populate the case number after the case number has been
initially entered. Continue filing the Memorandum or abort the filing by clicking on the
Criminal menu to restart this event. Page 31
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2. Click Next

The following window will appear:

ZECF o

Responses & Replies

0:08-cr-00007-ADK-AJB USA v Elingson

4Dy

Clearl

3. Confirm case number, Click Next

NOTE: With most events, a second case number verification window, Step 3 above, appears.
This window is another opportunity for the filer to ensure the correct case is being filed in.

From this point forward, Step 3 will only be listed; the screen shot will not be included.

The following window will appear:

Responses & Replies

0:08-cr-00007-ADM-AJB USA v. Cllinason

ALV

I

A

ilable Events (click to select an event)

Selected Event

Affidavit in Opposition to Motion
Affidavit in Support of Motion
Brief

LR7.1 Waord Count Compliance Certificate
Mermorandum in Opposition to Motion

Reply to Response
Response in Opposition
Response in Support
Response 1o Motion

Statement of Facts in Support of Exclusion of Time/Speedy Trial

Mext Clear |

[Memorandum in Support of Mation

4. Click the type of memorandum being filed. It will appear on the right side of the

window, Click Next
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The following window will appear:

5. Click on the party(s) filing the document, Click Next

NOTE: If you represent all defendants or all plaintiffs you may select the entire group by
holding down the control key while pointing and clicking on each party of the group.

From this point forward, Step 5 will only be listed; the screen shot will not be included.

A Notice of Appearance needs to be filed in order for the attorney to be added to the case
per the Criminal Procedures Guide, Section II. Electronic Filing and Service of Documents

The

window will appear:

cECF

Civil -~ Criminal ~ Query Reports ~ Utilities ~ Search Logout

following
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6. Click Browse to locate the appropriate document

The following window will appear:

|12 certificatenfservice, pdf
|| certificateafservice, wpd

[meme.pat

L1

'J;«u Files [

7. Navigate to the desired PDF document to be filed

NOTE: From this point forward Step 7, above, will be listed only; screen shot will not be included.

8. Click on the file and Click Open (or double-click on the file) to link it to thefiling

The following window will appear:

Criminal = Query Reports = Utilities - Search

C:\Documents and Settings\ellingso\My Browse_

9. Click Next

The following window will appear:
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10. Click in the box to select the event to which this memorandum relates, Click Next

The following window will appear:

MEMORANDUM in Support by Corey Ellingson re [10] MOTION for Discovery ||
{attorneyl, )

Nt [[| Clewr |

11. Click Next

The following window will appear:

NOTE: This is the last screen to view before submitting the pleading. If corrections need to be
made, click the Back button to locate the desired window in which to make changes.
To abort this filing event, click any item on the blue menu bar.

From this point forward, this informative note will not be included in the documentation.

MEMORANDUM in Support by Corey Ellingson re [10] MOTION for Discovery (attorney1,)

12. Confirm information in window, Click Next to submit the Memorandum

The following Notice of Electronic Filing will appear.
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NOTE: The Notice of Electronic Filing (NEF) confirms the completion of this filing event and that
is has been accepted by the ECF system.

This pleading is now an official court document.

From this point forward, this informative note will not be included in the documentation, and
the Notice of Electronic Filing step will only be listed; the screen shot will not be included.

Filing a Proposed Order
This section describes the process for filing a Proposed Order in ECF. In addition to filing the Proposed
Order in ECF, a copy of the Proposed Order must be emailed to chambers in word processing format.

1. Select Criminal > Motions and Related Filings> Supporting Documents and Responses

2. Review the ECF Filing Tip and click Next
3. Review the ECF Restriction Notice and click Next

4. Enter the case number and click Next
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5. Select Proposed Order to Judge re Motion and click Next

Available Events (click to select an event) Selected Event

Affidavit in Opposition to Motion |Pr0posed Order to Judge re Motion
Affidavit in Support of Motion

Brief

Meet and Confer Statement

Memorandum in Opposition to Mation

Memorandum in Support of Motion

Reply to Response

Response in Opposition

Response in Support

Response to Motion

Statement of Facts in Support of Exclusion of Time/Speedy Triz

6. Click on the party(s) filing the document, click Next

3

7. Confirm the correct defendant(s) is selected, click Next

8. Click Browse to attach the appropriate Main Document, click Next

9. Select the appropriate motion to which your proposed order relates, click Next
Select the appropriate event(s) to which your event relates:
0:16-cr-00001-DWF David Allan Smith

10/26/2016 8 (Ex Parte) Motion for for ex parte order, by David Allan Smith.
l Next I l Clear ]

10. Click Next

11. Confirm information in window, click Next to submit the filing
12. The Notice of Electronic Filing window will appear.

Filing a Position on Sentencing

This section describes the process for filing a Position on Sentencing in ECF. The process is
similar for filing other pleadings in ECF.

In this illustration, the ECF Search Feature will be used to locate Other Documents (the
appropriate event) in which to file the Position on Sentencing. This option may help to increase

efficiency for the Filer and the Court. The Search Feature may be used to locate any criminal filing
event.

To use the Search Feature:

1. Click Search
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The Search Menus and Events box will appear:

: C ivil ~ imil - Ad iliti ’
UE F Civil Criminal Query Reports Utilities Search agout

|Criminal Events Search Menus and Events

|sentenc| Search |
Motions and Related Filings

Motions ‘

Supporting Documents and Responses

Other Filings
Discovery Documents
Waivers
Service of Process
Notices
Trial Documents
Appeal Documents
Other Documents

2. Enter in part or all of desired search text, Click the Search button

The following window will appear listing the menus containing the result of the text search:

= - - - -

UE C F civil criminal Query Reports Utilities m
Search Menus and Events L}

Search results for ‘'sentenc’

4 avants found
[sentenc Search

Criminal Events — Moti

Reduce Sentence

Reduce Sentence re Crack Cocaine Offense - 183582
Set Asi

Criminal Events — Other Documents

Position on Sentencing/Sentencing Memorandum

—

3. Click on the appropriate Event Menu link to begin filing the Position on Sentencing

4. Enter in the case number

5. Click Find This Case

6. Click EECF civil ~ Criminal ~
Other Documents

Criminal Case Number

|03.07| Find This Case
EECF civil ~ c
e | Clear | Dther Documents

Criminal Case Number
|0-08-cr7
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The following window will appear:

Next| Clear |

7. Click Next

The following window will appear:

Infarmation 1o Establish Pror Convietion Paosition on Sentencing/Sentencing Memorandurm |
LR7.1 Word Count Compliance Certificate i

Letter re: withdrawal of document i

Letter to Clerks Office

Letter to District Judge

Letter to Magistrate Judge

Memaorandum

jection
jection To Discovery Ruling

jection ra: y of E y Filed D
jection to Report and Recommendations
Partial Satisfaction of Judgment

Petition

8. Click the type of memorandum being filed. It will appear on the right side of the
window, Click Next

NOTE: Because of the similarity to other events, minimal screen shots will be included in this section.

The following window will appear:

EE c F Civil ~ Criminal ~ Query Reports - Utilities ~ Search

Page 39



CMY/ECF User’s Manual - Criminal U.S. District Court, District of Minnesota

9. Click Browse to locate the appropriate document

10. Navigate to the appropriate directory and file name of the PDF document to be filed
11. Click on the File and Click Open (or double-click on the file) to link it to thefiling
12. Click Next

The following window will appear:

;EEII||'|;|§5|:=|'| Corey (1) [Detendant]

13. Click on the party(s) filing the document, Click Next

NOTE: If you represent multiple defendants you may select multiple parties by holding
down the control key while pointing and clicking on each party of the group.

A Notice of Appearance needs to be filed in order for the attorney to be added to the case
per the Criminal Procedures Guide, Section II. Electronic Filing and Service of Documents

The following Docket text window will appear:

POSITION ON SENTENCING/SENTENCING MEMORANDUM || | by Corey Ellingson
(Attachments: # (1) Certificate of Service) (attorneyl, )

Newt || Clea

14. Click Next

15. Click Next, again, to submit the filing

16. The Notice of Electronic Filing window will appear.
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Filing a Certificate of Service

Pursuant to Fed. R. Cr. P. 49(a)(3) service is completed by filing a document in ECF to a registered
user.

If service is not made through ECF, the filing party must file a certificate of service in ECF. The
certificate must state the manner in which service or notice was accomplished on each party so
entitled.

Filers are required to serve copies of any electronically filed pleading, document, or proposed
order to parties not served electronically by ECF according to the Federal Rules of Criminal
Procedure.

Certificates of Service can either be filed as: (a) an attachment in ECF during a filing or (b) a
separate filing. If the certificate of service is filed as an attachment to a filing, the filer must first
find out ahead of time who:

o will receive the filing by e-mail

e must receive hard copies of the filing
To determine the party mailing information, Click Utilities > Mailings > Mailing Info for a Case

1. Click Criminal > Other Filings > Service of Process

NOTE: Because of the similarity to other events, minimal screen shots will be included in this section.

2. Enter or confirm case number, Click Next, Confirm case number again, Click Next
3. Click the Certificate of Service, Click Next

4. Click Browse to locate the appropriate document

5. Navigate to the appropriate directory and file name of the PDF document to befiled
6. Click on the file and Click Open (or double-click on the file) to link it to thefiling

7. Click Next, Click on the party(s) filing the document, Click Next
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8. Check the box next to the appropriate event(s) to which your Certificate of Servicerelates.

9. Click Next
10. Confirm information in window, Click Next to submit the Certificate of Service

11. The Notice of Electronic Filing window will appear.
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Appendix A
Additional Information Regarding ECF

Sealed Documents

For more details about filing under seal, please refer to the Criminal Procedures Guide, Section II,
part B and the Sealed Criminal User’s Manual.

Documents Filed In Error

A document incorrectly filed in a case may result from: a) uploading the wrong PDF file to a docket
entry; b) entering the wrong case number and not discovering the error before completing the
transaction; or c) selecting the wrong document type from the menu.

Uploading the wrong PDF file to a docket entry or entering the wrong case number

After a document is filed electronically, corrections to the docket must only be made by the Clerk’s
Office. ECF will not permit the filer to make changes to the document(s) or docket entry once the
transaction has been submitted.

Documents filed in error in the correct case (e.g., wrong version of the document attached, wrong
event code, etc.) must remain part of the record as filed. Upon discovery of error, the filer must:
Call the Clerk’s Office Help Desk at 612-664-5155 or866-325-4975. Clerk’s Office staff will edit the
docket text of the incorrect entry indicating “DOCUMENT FILED IN ERROR” in all caps at the
beginning of the docket entry. The user should immediately file the correct document in the case in
ECF, and modity the title of the pleading as appropriate (e.g., "Amended", "Substituted",
"Corrected").

If a document is filed in the wrong case, the filer must immediately call the Help Desk at 612-664-
5115 or866-325-4975. The Clerk’s Office will edit the docket text of the incorrect entry indicating,

“DOCUMENT RESTRICTED-FILED IN WRONG CASE” in all caps at the beginning of the docket
entry. The user should then file the document in the correct case.

Selecting the wrong document type

In the event you selected and highlighted a file that is not in PDF format, ECF will display the
following error message after you click on the [Next] button.

Criminal ~ Query Reports - Utilities -
Motions
0:08-cr-00007-ADM-AJB USA v_Ellingson
4DV

ERROR: Document is not a well-formed PDF document (no further information is available).
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1. ECF will not permit you to select a file for your pleading that is not in PDFformat.
2 Click on the [Back] button and ECF will return to the attachmentscreen.
3. Select and highlight the PDF file of your pleading and proceed as before.

Failure to Select a Document to File

If you fail to select a document to file with your pleading, ECF will display the error message

depicted below.
& Moke: ¥ou have not selecked a document,

If you click [OK] from the screen depicted above ECF will return you to the Attachments screen.
You cannot proceed without attaching a PDF document.

Attachments and Attachment Size

Attachments electronically filed must be less than 35 MB or 35,840 KB in size, after the document
has been converted to PDF.

Attorneys may seek leave of the court to file conventionally if attachments and exhibits are
voluminous. Refer to the Criminal Procedures guide, Section VI. Leave to File Conventionally for
more details on this matter.

NOTE: For moderate length paper attachments, consider dividing them into two or more smaller
attachments, scanning, and filing them electronically.
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Appendix B
Viewing Restricted Filings in ECF

Documents electronically filed in ECF may have different restriction levels, i.e. sealed, court only,
applicable party, or ex parte. When both the document and the docket entry are restricted, the
docket report will have skipped document numbers. A text only entry will indicate that the
document is restricted and identify its docket number.

If a user does not have appropriate access to view a restricted document, when clicking on the
document number, the user will be prompted with a message stating the document is not
available, or you do not have permission to view this document.

If a document is restricted and the user has appropriate access to it, when clicking the on the
document number the user will be prompted for his/her CSO login. This is simply a security
measure to ensure that the user has proper access to view the document(s).

***NOTE TO PUBLIC ACCESS USERS*** You may view the filed documents once without charge. To avoid later charges, download a
copy of each document during this first viewing.

U.S. District Court

District of Minnesota
Notice of Electronic Filing
LMD T LAttt T IR and filed on 12/21/2005
Case Name: Small v. HIS

_ 0:01-cv-747

Password *

Client/Code

Logm Llear Lancel
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Appendix C

PACER Fees Window
When accessing or printing a document that incurs PACER fees a Transaction Receipt table
appears at the bottom of the window. As seen below, this table provides the total charges billed.

| PACER Service Center

| Transaction Receipt

[ 11/1372013 15:48:22

[PACER Login: [us8632 [Client Code: |

[Description:  [Docket Report [Search Criteria: [0:12-cv-00003-INE-JIG
|Bi1hble Pages: ]1 |Cosl: ]u.w
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Appendix D
The Federal Rules and Personal Identifiers

Under Fed. R. Crim. P. 49.1(a), unless the court orders otherwise, an electronic or paper filing with
the court that contains an individual’s social-security number, taxpayer-identification number, or
birth date, the name of an individual known to be a minor, or a financial-account number, or the
home address of an individual, the party or nonparty making the filing may include only:

a. The last four digits of the social-security number and taxpayer-identificationnumber;

b. The year of the individual’s birth;

¢. The minor’s initials;

d. The last four digits of the financial-account number; and

e. The city and state of the home address.
In addition, exercise caution when filing documents that contain the following:

. Personal Identifying Number (e.g., driver’s license number);

g Medical Records, Treatment and Diagnosis;

h. Employment History;

i Individual Financial Information;

j Proprietary or Trade Secret Information.

Under Fed. R. Crim. P. 49.1(b), the redaction requirements do not apply to the following:
a. A financial-account number or real property address that identifies the property
allegedly subject to forfeiture in a forfeiture proceeding;
b. The record of an administrative or agency proceeding;

c. The official record of a state-court proceeding;

d. The record of a court or tribunal, if that record was not subject to the redaction
requirement when originally filed;

e. A filing covered by Rule 49.1(d) ; and

f. A pro se filing in an action brought under 28 U.S. C. §§ 2241, 2254, or 2255.
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g. A court filing that is related to a criminal matter or investigation and that is prepared
before the filing of a criminal charge or is not filed as part of any docketed criminal
case;

h. An arrest or search warrant; and
i. A charging document

Pursuant to Fed. R. Crim. P. 49.1, in addition to filing a redacted version of the document in ECF, a
party filing a document containing personal identifiers may also file:

1. An unredacted copy of the document under seal without seeking leave of the court in
accordance with Section V.D. of the Criminal ECF Procedures Guide regarding filing
documents under seal; or

2. A reference list under seal without seeking leave of the court in accordance with Section
V.D. of the Criminal ECF Procedures Guide regarding filing documents under seal. The
reference list must contain the complete personal identifier(s) and the redacted identifier(s)
used in its place in the filing.

To file documents containing personal identifiers:
1. File the redacted version of the document electronically in ECF.

2. If filing an unredacted original under seal, the filer must:

a. Clearly state one of the following in the document heading;:

i. SEALED PURSUANT TO FED. R. CRIM. P. 49.1- UNREDACTED ORIGINAL
(Redacted Document filed in ECF as Document # [number]); or

ii. SEALED PURSUANT TO FED. R. CRIM. P. 49.1 - REFERENCE LIST (Redacted
Document filed in ECF as Document # [number]).

b. File the sealed unredacted original or reference list electronically in ECF.

Mail or deliver TWO COURTESY COPIES (with a copy of the NEF) of the sealed document, as
required by Section I, Part F of the Criminal ECF Procedures Guide, to the District or Magistrate
Judge handling the matter in a separate envelope.

a The sealed document shall be served conventionally, with a copy of the Notice of
Electronic Filing (NEF), by the filer on parties who are entitled to service. The e-notice
of the court’s receipt of these documents shall not constitute service.
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Sample of Reference List of Personal Identifiers Redacted

UNITED STATES DISTRICT COURT
DISTRICT OF MINNESOTA

[Plaintiff’s Name] Case Number: [Case Number]
Plaintiff(s)

V. REFERENCE LIST OF
PERSONAL IDENTIFIERS
[Defendant's Name] FILED UNDER SEAL PURSUANT TO THE
FED.R. CIV.P. 52 AND
Defendant( S) FED. R. CRIM. P. 49.1

The following personal identifiers have been redacted pursuant to the Fed. R. Civ. P. 5.2 and
Fed. R. Crim. P. 49.1. Below is a listing of the complete personal identifier and its
corresponding partially redacted version. The redacted version will be used in lieu of, and shall
be construed to refer to. the corresponding complete identifier in filings in the above referenced

case.
Description of Identifiers Complete Identifier Partially Redacted
Redacted Identifier
Social Security Number 123-45-6789 XXX-XX-6789
Financial Account Number 987-66-54-321 XXX-XX-X4-321
Name of Minor Child Jane Doe 1.D.
Date of Birth 07-04-2004 2004
Home Address (criminal cases only) 123 Main St Smithville, MN
Smithville, MN 12345
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Appendix E
Creating an Appendix with Document Links

A set of radio button options labeled Include documents in Appendix and Include document
hyperlinks in Appendix appear at the bottom of the Docket Report. These options allow users to
indicate if the PDF documents they selected for inclusion in the appendix docket sheet should be
appended to the docket sheet or if hyperlinks to those documents should be included instead.

Options for Creating an Appendix
When the Docket Report is run with the Create Appendix option selected, two radio buttons are
included at the bottom of the report: Include documents in Appendix and Include document

hyperlinks in Appendix.

U.S. District Court
U.5. District Court Minnesota (DMN)
CIVIL DOCKET FOR CASE #: 0:11-cv-00010-JNE -AJB

Ellingzon v. U 5. Bureau of Prisons Date Filed: 05/27/2011
Assigned to: Judge Joan M. Ericksen Jury Demand: None
Referrad to: Magistrate Judge Arthur J. Bovlan Mature of Suit: 330 Habeas Corpus (General)
Cavse: 28:2254 Petition for Writ of Habeas Corpus (Stat=) Turisdiction: U.5. Defend:
Plaintiff
Bella Ellingzan represented by Bella Ellingzon
PROSE
V.
Defendant

U.5. Bureau of Prizonz

DateFiled | #|dar % |DocketText
ospaonl (1 (- PETTTION for Wit of Habeas Corpu { Filing fae $ 5 receipt number 500400.) assizned t Todze Tozn N. Exicksen per Prisoner referred to Magistrate Fodee Acthur 1. Boylan., filed
by Bella Eflingson. (Attachmants: 2 1 Civil Cover Shast) (IME) (Entersd 05/27/2011)
oszizon (2| | MOTION to Dismiss by U.S. Bursay of Prisons. (IME) (Eatersd: 05/27/2011)
ospmaon (3 [ REPORT AND RECOMMENDATION re 1 Patition for Wit of Habeas Corpus filad by Balla Ellingson. Objactions to R&R due by 6/6/2011_ Signad by Magistrate Jodge Arthur 1
Boylan on 5/27/2011. (IME) (Entersé: 05272011
Footer format: [<s=genum> 1% Include full docket sheet (D b e e B e
(urmbars, latters, spacss, and pagenwm> only) (g o e perlinkcs in A
View Selected
=
Download Selected I

Creating an Appendix with the “Include documents in Appendix” Option
If the Include documents in Appendix option is selected when the appendix is generated, the
application produces a PDF version of the docket sheet with the selected documents appended.

Creating an Appendix with the “Include document hyperlinks in Appendix” Option

If the Include document hyperlinks in Appendix option is selected when the appendix is generated,
the application produces a PDF version of the docket sheet that does not include the documents
from the case record.

Instead, this PDF includes document hyperlinks which direct the user clicking on them back to the
District court’s CM/ECF application to view the document(s).
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Sample Appendix PDF with Document Hyperlinks:

U.S. District Court
U.S. District Court Minnesota (DMN)
CIVIL DOCKET FOR CASE #: 0:11-cvy-00010-JNE -AJB

Ellingson v. U.S. Bureau of Prisons Date Filed: 05/27/2011
Assigned to: Judge Joan IN. Encksen Jury Demand: INone
Feferred to: Magistrate Judge Arthur J. Boylan Namre of Suit: 330 Habeas Corpus
Canse: 28:2254 Petition for Wit of Habeas Corpus (State) (General)
Jumsdiction: U5, Government Defendant
Plaintif
Bella Ellingson represented by Bella Ellingson
PROSE

.
Defendant
U5, Burean of Prisons

Date Filed # Docket Text

03/27/2011 1 |PETITION for Writ of Habeas Corpus ( Filing fee § 5 receipt number

500400.) assigned to Judge Joan M. Enicksen per Prisoner referred to
MMagistrate Judge Arthur J. Bovlan., filed by Bella Ellingson.
(Attachments: # 1 Crvil Cover Sheet) (JME) (Entered: 05/27/2011)

05272011 2 |MOTION to Dismiss by 1.5, Bureau of Prisons. (JME) (Entered:
057272011y
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Appendix G

Accessing the New Cases Report

The New Cases Report lists new civil and criminal cases filed in the U.S. District Court, District of
Minnesota each day. It indicates the date and time (within the hour) the case was assigned, case
number, case name, the District Judge assigned to the case, and the Magistrate Judge assigned to
the case. The information will be available on the New Cases Report for 30 days. This report is
designed to assist the public with viewing new case filings in the U.S. District Court. The Judge
assignments in the New Cases Report are listed with their initials. Click on the Judge Initials link
to view a listing of the Judge’s initials and corresponding full names.

1. To access the New Cases Report click on the District of Minnesota’s Web site at:
www.mnd.uscourts.gov

2. Click on the New Cases tab> Access to the New Cases Report.

| New Cases Report from 10/21/2012 to 11/20/2012
Time . c

‘Date Reported Case # Title Type Judge Magistrate

11/192012 11/19/2012 12ev2017 Kennedy v. Astrue Type: Social Security - 381D Title XVI PIS FLN
17:00:01

11/19.2012 11/19/2012 12ev2916 Signus Medical LLC v Ilion Medical LLC Type: Pending DWF |[TNL
17:00:01

11/19/2012 11/19/2012 12ev2015 Johnson v Nerthwest Eye Clinic, PA Type: Pending INE ATB
17:00:01

11/19:2012 11/19/2012 12ev2914 Edoff v ARS Mational Services, Inc., et al Type: Pending MID  |TIG
17:00:01

11/192012 11/19/2012 12cv2913 Anytime Fitness v Roberts et al Tvpe: Property Rights - Trademark SEN |[IG
16:00:01

11/19/2012 11/19/2012 12ev2912 US v Whalen Type: Other Statutes - Other Statutory Actions PIS SER
16:00:01

11/19:2012 11/19/2012 12ev2011 Brynteson v Life Insurance Company of North Amenica | Type: Pending ADM ||TNL
16:00:01

11/19:2012 11/19/2012 12ev2910 Stover v Astrue Type: Social Security - DIWC/DIWW INE [FLN
16:00:01
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Appendix H
Mobile Query

The mobile query interface offers a simplified user experience optimized for display on mobile

devices. This interface incorporates the following functions:

e Search interface
e Party selection from party name search result list

e Case selection from case search result list based on case or party namesearch

e Attorney information for selected case
e Party information for selected case

e Deadlines/Hearings for selected case
e Docket entries for selected case

Accessing the Mobile Query

Users can access the mobile query via one of the following locations:

1. The Mobile Query link on the Query selection criteria page:

Case Number |

or search by

Query
ARNING: Search results from this screen are NOT subject to the 30 page limit
on PACER charges. Please be as specific as possible with your search criteria.
Search Clues Mobile

Last/Business Name l— " Exact matches onty
First Name I— Middle Name I—
Type  H=

Run Query | M

Case Stamus Copen  Closed Al
Filed Date | to |
Last Entry Date | to |
- D (zero) ﬂ
Nature of Suit 110 {Insurance)
120 (Contract: Marine) ;I
4
. 0 (No cause code entered)
Cause of Action | (5.0431 (02:431 Fed. Election Commission: Failure Enforce C)
02:0437 (02:437 Federal Election Commission) ;I

2. The Mobile Query link on the Query results page.

Donovan W. Frank, panel 1
Diana Murphy. panel 2
Michael J. Davis, panel 3
Steven E. Rau, referral
Date filed: 05/12/2009
Date of last filing: 09/11/2013

hMobile

Query
Alias
Associated Cases
Attorney

3. A case link from the mobile PACER Case Locator.

0:09-cv-00086-DWF-DEM-MJD Ellingson v. Ellingson
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Mobile Query User Interface

All interfaces in the mobile query include five elements on each page:

1. Back button ;

2. Title CM/ECF Mobile—MND;
3. Logout button E;

4. Court home page button n;
5. Search field for party name or case searches.

CM/ECF Mobile - MND n

Case Mumber or Last. First

Search for a case by entering either a case number or the name of a party or attorney in the
search box above. Spaces can be used in case numbers instead of dashes or other punctuation.
When searching by name, you must enter at least two letters of the last name. If you enter only
one letter the search will only find people whose last names are exactly that letter.

% CM/ECF Mobile - MND L3
|

Login (

Password ! ‘

Client Code

| |

TEST Full Site

The default search screen contains one text field that allows users to search by case number, party
name, or attorney.

At the bottom of each page, a Full Site button provides access to the standard-formatted
application interface page. If the user clicks the Full Site button, the full site is set as the default
for approximately twelve hours. If any specific page generates a PACER billing receipt, a
summary form of the billing information is displayed in the black bar along the bottom of the
page.
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CM/ECF Mobile - MND

Case MNumber or Last, First

Search for a case by entering either a case number or the name of a party or attorney in the
search box above. Spaces can be used in case numbers instead of dashes or other punctuation.
When searching by name, you must enter at least two letters of the last name. If you enter only
one |etier the search will only find people whose last names are exactly that letter.

TEST Full Site

Name Searches

For name searches, the required format is Last Name, First Name, where a comma separates the
two parts. The first name is optional. When searching by name, the user must enter at least two
letters of the last name. If only one letter is entered, the search will only find parties or attorneys
whose last names are exactly that letter.

If a party name search returns more than one possible match based on the criteria provided, the
mobile interface presents the user with a list of all matching names and requires the user to
select a specific name.

CM/ECF Mobile - MND

Case Number or Last, First

Filter items..

36 Matching Names for johnson

Johnson (pty)

Adam Johnson (aty)
Adam Johnson (pty)
Anna Johnson (pty)
Ashley Johnson (pty)

Brian P Johnson (aty)

© © 0 0 0 0 ¢

Carol Johnson (pty)

©

Cecil Johnson (pty)

Pages: 1, Cost: 0.10 TEST Full Site
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If more than eight results are returned on any query page (excluding the docket entries page),
above the list, an on-page filter allows the user to search the results already downloaded to the
browser. This does not affect PACER billing.

CM/ECF Mobile - MND

Case Number or Last, First

|f,' ' Filter items... . |l

36 Matching Names for johnson

Johnson (pty)

Adam Johnson (aty)
Adam Johnson (pty)
Anna Johnson (pty)
Ashley Johnson (pty)

Brian P Johnson (aty)

© 00 0 0o o

Carol Johnson (pty)

©

Cecil Johnson (pty)

Pages: 1, Cost: 0.10 TEST Full Site

If only one case is linked to a specific name, the case results for that case is returned.

CM/ECF Mobile - MND

Case Number or Last, First

0:13-cv-00026 Filed: 02/21/2013
Johnson v. Doe et al

Attorneys (>
Parties ©
Deadlines / Hearings ©
Docket Entries 2 D

TEST Full Site
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If one name matches the initial search but is linked to multiple cases, or if a user selects a name
from the result list of a multi-response search, a list of cases associated with that party is displayed.
When a case is selected from this list, the case query result page is displayed.

CM/ECF Mobile - MND

Case Number or Last, First

Filter items. .

103 Cases

0:07-cv-00145-MJD-FLN
Ellingson v. Mehl

0:08-cr-00013-JNE-1
David Smith

0:09-cv-00018-JRT-JJG
Gleason v. Barnes

0:09-cv-00097-DWF-RLE
Gleasonv. Bames

0:10-cv-00046-RHK-X
Smith v. Jones

© | © © © ©

0:11-cr-00057-MJD-AJB-2 0
Tom Jones

Pages: 3, Cost: 0.30 TEST Full Site

Case Searches

Entering a numeric search term triggers a case number search. If an alphanumeric search term
is entered, it triggers a party or attorney name search. If a case number search returns no
results, the system automatically runs a name search using the same terms. Spaces can be used
in case numbers instead of dashes or other punctuation.

The case number search does not generate a PACER billing receipt, since the standard query
application does not bill for the case number lookup.

If a case search returns more than one possible match based on the criteria provided, the mobile
interface presents the user with a list of all matching cases and requires the user to select a
specific case before proceeding to the case query result screen. When a case is selected from this
list, the case query result for that specific case is displayed.
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CM/ECF Mobile - MND

Case MNumber or Last, First

3 Matching Cases for 121

0:12-cr-00001-JNE-JSM ©
USAw Smith et al

0:12-mc-00001-MJD-FLN
United States of Americav. Johnsaon

0:12-mj-00001-JJK
USAw Search Warrant

TEST Full Site

If only one case matches the case criteria provided, the case query result page is displayed.

CM/ECF Mobile - MIND

Case Mumber or Last, First

0:12-cr-00001-JNE-J SM
USA v. Smith et al

Attorneys ©
Parties ©
Deadlines / Hearings ©
Docket Entries 25 | D

TEST Full Site

Case Query Results

When a search is run, the Mobile Query displays results in the case query result page (see figure
1). This screen presents the following information:

e case number, short title, and date filed;

¢ link to see attorney information in the case;

e link to see party information in the case;

e link to see deadline/hearing information in the case;

e link to show all docket entries, and the number of docket entries that will beshown;
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e search icon that brings up a search box to find docket entry information that matchesthe
text entered, (see figure 2).

The Case Query Results screen is similar to the full site Query result page, which does not
produce a PACER billing receipt. Billing will occur based on additional selection from this page.

Figure 1-Case Query Result Figure 2-Docket Entry Text Search

) CMIECF Mobile - MND 0) *
Case Number or Last, First

) CM/ECF Mobile - MND (©) -@

Case Number or Last, First

0:12-cr-00001-JNE-JSM
USA v. Smith etal

Filed: 01/12/2012

TEST

Full Site

0:12-cr-00001-JNE-JSM Filed: 11122012
Attorneys © USA v. Smith et al
Parties © Attorneys ©
Deadlines / Hearings © Parties ©
Docket Entri |
aem A = Deadlines / Hearings ©
|l“ *\ Saarch Docket Entries i)

TEST Full Site

Detailed Case Information Displays

Attorneys, parties, deadlines, and docket entries are listed in similarly formatted lists that wrap
to fit on small screens.

Each list header shows the case number, item listed, and the number of matches. If more than
eight items appear in the list, a Filter Items search box at the top of the list allows the user to
narrow down the list. This Filter Items search box is available on all case details except for
docket entries. The user is billed for receiving the total data, not for using this filter to hide data
already received.

Attorney Information

CM/ECF Mobile - MND

Case Number or Last. First

2 Attorneys for Case 0:12-cv-00148-DSD-JJK

Lynn Attorney
testattorney@mnd.uscourts.gov
rep. ABC Corporation (Defendant)

|
Marsha Clark ‘

(612) 664-5600 testatty2@mnd.uscourts.gov
rep. Jackie Ellingson (Plaintiff)
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Party Information
CM/ECF Mobile - MND

Case Number or Last, First

2 Parties for Case 0:12.cv 00148 DSD-JJK

ABC Corperation
Defendant

Jackie Ellingsen
Plaintiff

Full Site

Deadlines/Hearings Information

2 CM/ECF Mobile - MND

Case Number or Last, First

5 Deadlines/Hearings for Case 0:

9

Amended Pleadings Deadline
DuefSet 10/01/2013

3 Motion (non-disp) Filing
DuefSet 11/14/2013

9 Motions (disp) Deadline
DuefSet: 1219/2013

9  Ready for Trial Deadline
DueiSet: 01/16/2014

Docket Entries Information

CM/ECF Mobile - MND

Case Number or Last, First

6 Docket Entries for Case 0:12-cv-00148-DSD-JJK

1 09/25/2012 COMPLAINT against ABC Corporation. { Filing fee § 350 receipt number
0864-183855.), filed by Jackie Ellingson. Filer requests summons issued. (Attachments: # 1
Civil Caver Sheet) (Clark, Marsha)

2 (9/25/2012 TEXT-ONLY ENTRY. CLERK'S NQTICE OF INITIAL CASE ASSIGHMENT. Case
assigned to Judge David S. Daty per Master list referred to Magistrate Judge Jeffrey J.
KeyesPlease use case number 12cv148 DSDAK for all subsequent pleadings. (JME)

09/26/2012 ANSWER to Complaint by ABC Carporation. (JME)

09/27/2012 MOTION for Admission Pro Hac Vice for Joe Attorney by Jackie Ellingson. (JME)
Modified on 9/27/2012 (JME).

5 09/27/2012 ORDER granting 4 Mation for Pro Hac Vice Attomey Joe Attomey for Jackie
Ellingson. Fee paid; receipt number 400-500.. Signed by Judge David S. Doty on 9/27/2012.
(IME)

05/16/2013 SCHEDULING ORDER:. Amended Pleadings due by 10/1/2013. Motions
oo duo 444000 ; i=pi dus (47 Daady for trial dua b

Full Site
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Docket Entries Using Text Search

X CM/ECF Mobile - MND

Case Number or Last, First

0:12-cv-00148-DSD-JJK Filed: 0912572012

Ellingson v. ABC Corporation

Attorneys (5]

Parties ©

Deadlines / Hearings ©
order (%))

Full Site

CM/ECF Mobile - MND

Case Number or Last, First
2 Docket Entries for Case 0:12-cv-00148-D5D-JJK Matching order

5 09/27/2012 ORDER. granting 4 Motion for Pro Hac Vice Attomey Joe Attorney for Jackie |
I Ellingson. Fee paid: receipt number 400-500_. Signed by Judge David S. Doty on 9/27/2012. |
|

| (JME)
9 09/16/2013 SCHEDULING ORDER:. Amended Pleadings due by 10/1/2013. Motions (non-disp)
‘ due 11/14/2013. Motions (disp) due by 12/19/2013. Ready for trial due by 1/16/2014. Signed by
Magistrate Judge Jeffrey J. Keyes on 9/16/13. (JME) |

Pages: 1, Cost: 0.10 TEST Full Site
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The docket entry information includes document numbers, the filed date, and the docket text.
For documents, the document number appears in its own cell on the left. The entire cell is
clickable to make clicking the link easier on small screens. Clicking on a document takes the
user to familiar ECF screens to view the document.

CM/ECF Mobile - MND

Case Number or Last, First

1

[

%)

=]

& Docket Entries for Case 0:12-cv-00148-DSD-JJK

09/25/2012 COMPLAINT against ABC Corporation. { Filing fee $ 350 receipt number 0864-183855.), filed by Jackie
Eling=on. Filer requests summons issued. (Attachments: # 1 Civil Cover Sheet) (Clark, Marsha)

09/25/2012 TEXT-ONLY ENTRY. CLERK'S NOTICE OF INTIAL CASE ASSIGNMENT. Case assigned to Judge David S.
Doty per Master list referred to Magistrate Judge Jeffrey J. KeyesPleaze use case number 12cv148 DSDVLIK for all
=ubseguent pleadings. (JME)

09/26/2012 ANSWER to Complaint by ABC Corporation. (JME)

08/27/2012 MOTION for Admizssion Pro Hac Vice for Joe Attorney by Jackie Elingson. (JME) Modified on S/27/2012
(IME).

09/27/2012 ORDER granting 4 Motion for Pro Hac Vice Attorney Joe Attorney for Jackie Elingzon. Fee paid; receipt
number 400-500.. Signed by Judge David S. Doty on Q27/2012. (IME)

09/16/2013 SCHEDULING ORDER:. Amended Pleadings due by 10/1/2013. Motions (non-diep) due 11/14/2013.
Motions (disp) due by 12/19/2013. Ready for trial due by 1/16/2014. Signed by Magistrate Judge Jeffrey J. Keyes on
9116113, (JME)

Pages: 1, Cost: 0.10 TEST Full Site

The mobile query ignores PACER billing display preferences and displays PACER receipts via
the standard ECF PACER interface.

EECF Query  Reports  Ufilitiez  Logout

To accept charges shown below, click on the View Document' button, otherwise click the Back' button on your browser.

View Document |

‘ Pacer Service Center
| Transaction Receipt

| Tia Sap 17 10:30:36 2013

Bacer Login:  [usB63  [Client Code: |

Description:  [fmsg00 [Case Number: [0:12v00141DSD-ITK
[Billable Pages: |1 [cost: [0
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